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Welcome to DataFlex Reports 2017 Developer Edition – 6.1.5  
 
 
Important information for existing DataFlex Reports users: 
 
Existing reports  
The .dr (or .vrw for older reports) report definition format has changed between version 5.x and 6.x. If 
you save reports with this version of DataFlex Reports, you can no longer use them in previous versions. 
 
Special caution with regards to this: when opening reports that were created with an older version it is 
advised to run the ‘check database’ option. 
 
Font sizes are calculated differently in version 6.0 and up of DataFlex Reports. This can have 
an effect on the layout of existing 5.0 reports. 
DataFlex Reports version 6 calculates font sizes differently compared to previous versions. This means 
the overall size of text may differ and can cause clipping of fields which did not occur in previous 
versions. Also, when using small fonts (less than 10 pts) the text may appear more greyish compared to 
previous versions.  
 
String comparison in expression evaluator 
String comparison in previous versions of DataFlex Reports (up to and including DataFlex Reports 6.0 
Beta I) were case-insensitive. Starting with version 6 Beta II, a new option ‘Use case-sensitive 
comparison in functions’ has been added to address what should be considered a bug. For example the 
following function would return “case insensitive”. 
 
if ("A" = "a") then 
     return "case insensitive" 
end 
 
The option ‘Use case-sensitive comparison in functions’ is turned on by default for new reports. Existing 
reports have this option turned off to ensure backward compatibility. We strongly recommend you keep 
this option turned on for all new reports and advise you check your existing reports and turn this option 
on if your report(s) do no rely on case-insensitive string comparison. 
 
Please note only string comparison operators <, <=, =, >=, > and <> are affected by this option. 
 
Deployment 
Before deploying please update the integration library in your workspace(s) and recompile your 
application(s). 
 
Integration library changes 
The existing cWebDRReport class which was introduced in DataFlex Reports version 4 is now considered 
obsolete. The class is still available for backward compatibility but there are no functional differences 
between the cWebDRReport and cDRReport classes. The availability of web only properties and methods 
is determined by the project type (Windows of Web) being compiled. 
 
Previous versions of the integration library wizard generated the events ‘OnProgressRecorsRead’ and 
‘OnProgressFormatPage’ when creating code for a windows project. These events are no longer 
generated and the events can be removed from existing code if not altered. 
  
Use of IS$WEBAPP in DataFlex Studio 
To ensure the DataFlex Studio will correctly handle labels for GUI controls and avoid warnings in the 
problem resolution panel of the DataFlex Studio you should add the IS$WEBAPP to the Tools | Configure 
Workspace | Conditionals | Workspace #IFDEF conditionals for your DataFlex Studio version 16.0 - 19.0 
Windows GUI applications. 
 
New cWebDRReportViewer class 
The cWebDRReportViewer class is updated. Please make sure you check the ‘Copy APPHTML\DataFlex 
Reports Folder contents’ checkbox after attaching the new integration library in your web projects.  
 
  



Important Information – Please Read Carefully  
 
DataFlex CodeJock controls  
DataFlex Reports uses the same version of the CodeJock components as DataFlex 18.0/18.1. If you 
uninstall DataFlex Reports you must manually run the ‘RegisterCodejockControls’ batch file in the 
DataFlex bin directory to ensure that DataFlex 18.0/18.1 will continue to run correctly.  
 
Installation  
DataFlex Reports 2017 – 6.1.5 is developed with DataFlex 18.2. If you do not have a version 18.2 Client 
License running on your PC, the setup will automatically install one for you. 
 
DataFlex 16.x, 17.x, 18.x or 19.0 Studio license is required to use the Integration library which is part of 
DataFlex Reports 2017 Developer Edition. 
 
DataFlex Reports 2017 – 6.1.5 cannot run side-by-side with version 6.1.x, you need to uninstall version 
6.1.x before installing 6.1.5 
 
To run your applications with version 6.1.5 you must detach the DataFlex Reports Integration library and 
attach the library installed with version 6.1.5. 
 
 
Supported platforms 

- Microsoft Windows 10 
- Microsoft Windows 8 excluding RT  
- Microsoft Windows 7 Home Premium or higher  
- Microsoft Windows Server 2012 including R2 
- Microsoft Windows Server 2008 including R2 

o All of the above are supported in 32 and 64 bit editions 
- Windows Terminal Services when using Windows Server 2012 or Windows Server 2008 
- Citrix XenApp when used in conjunction with other supported Windows operating systems  

 
Registration DataFlex Reports 6.1.5 will run as a 60-day trial version. If you start DataFlex Reports you 
will be asked to register your version. To register, you need to purchase a license. Registering will lift 
the trial period. After registering your license you have a 60 day period to activate your license. Make 
sure you have an internet connection, and simply confirm the activation. 
Click here to learn where you can order your license.  
 
 
  



Changes between 6.1.4 and 6.1.5 
- HDE 5197 https://support.dataaccess.com/Forums/showthread.php?60060-Re-New-Version 
- HDE 5140 https://support.dataaccess.com/Forums/showthread.php?61963-Text-Object-

Problem 
- HDE 4847 Collapse all option  for Report Explorer 
- HDE 4481 https://support.dataaccess.com/Forums/showthread.php?59345-DR-File-Path-in-the-

statusbar-please 
- HDE 5180 Fixed problem with purged functions 
- HDE 5127 Undo button does not work with Pagelayers 
- HDE 4834 Implemented Alt+Up and Alt+Down for Report Explorer and Experts 
- HDE 4440 Save or Save as of a report with a .vrw extension will change extension to .dr 
- HDE 5129 https://support.dataaccess.com/Forums/showthread.php?61964-Another-Problem 

 
Library: 

- HDE 5178 DRExportOptions.dg sets the filename to the correct extension 
- HDE 5196 Fixed problem in Wizard when using Windows integration 
- HDE 5131 Fixed problem when clicking in preview before report has run 

 
Changes between 6.1.3 and 6.1.4 

- HDE 4683 Keep RDS sample data after changing RDS database 
- Allow RDS name to be changed 
- HDE 5103 Fixed problem with reports bases on SQL statement with string parameters 
- HDE 5075 Fixed problem with RDS alias names 
- HDE 5104 https://support.dataaccess.com/Forums/showthread.php?61754-Using-SQL-

Statement-with-Parameters-as-Report-s-Datasource 
- HDE 3618 Added row number column in RDS sample data dialog 
- HDE 5079 Fixed problem with purge functions not working in Maintenance tool 
- HDE 5072 Fixed problem with Shift-Click not working in the Report Explorer 
- HDE 5084 Fixed Invalid message ‘OnExitObject’ when focus moves to Report Explorer while 

editing a text object 
- HDE 5082 https://support.dataaccess.com/Forums/showthread.php?61766-Report-crashes-

when-filtering-subreport-on-text-field 
- HDE 4691 Added ability to remove the collating sequence in report, the F5 key now resets to 

default collate 
- HDE 5098 Fixed problem with default column in Insert Group dialog 
- HDE 5082 https://support.dataaccess.com/Forums/showthread.php?61766-Report-crashes-

when-filtering-subreport-on-text-field 
- HDE 5109 Fixed ‘Referenced array index out of bounds’ error in Report/Field Explorer 
- HDE 5112 Top & bottom border of a subreport are not printed when Page header / footer are 

hidden in the subreport 
- HDE 5107 https://support.dataaccess.com/Forums/showthread.php?61897-DR-6-1-3-Sub-Sub-

Report-Alignement 
- HDE 5046 https://support.dataaccess.com/Forums/showthread.php?61615-Pressing-F1-for-Help  
- HDE 4918 https://support.dataaccess.com/Forums/showthread.php?61128-DataFlex-reports-

RC-II-function-editor-annoying-thing-with-SHIFT-TAB 
- HDE 4931 https://support.dataaccess.com/Forums/showthread.php?61203-Clicking-on-

SubReport 
- HDE 4865 https://support.dataaccess.com/Forums/showthread.php?60944-Multiple-Object-

Selection-in-Report-Explorer&highlight=report+explorer 
- Updated integration library 
- Updated help 
 

Changes between 6.1 and 6.1.3 
- Fixed type conversion problem in SQL() function 
- Binary data can now be stored in RDS sample dialog 
- Fixed problem with saving functions when switching between functions in the function editor 
- HDE 5062 Increased maximum font size from 100 to 500 pts 
- HDE 5035 Empty functions are no longer automatically deleted 
- HDE 5042 Fixed problem with background color for barcodes 
- Updated integration library 
- Updated help 

 
Changes between 6.0 and 6.1 

- Managed connection support (use the ODBC driver to use the new Managed Connections) 
- Added Russian language & collate 
- Added Hungarian language 
- Navigating in the report explorer now selects object in the design tab 



- Added Show Subreports option to Function Explorer 
- Added Find by Function ID option to Function Explorer 
- Added Import registration information to Registration dialog 
- Updated documentation 

 
Bug fixes: 

- HDE 4914 https://support.dataaccess.com/Forums/showthread.php?61045-DR6-0-RC-Crashing-
after-quot-Check-Database-quot 

- HDE 4950 Page layers only appear on first two pages 
- HDE 4937 ODBC memo fields have a default height/length of zero 
- HDE 4959 Validate Collate file name in designer 
- https://support.dataaccess.com/Forums/showthread.php?61208-Adding-Stored-Proc-to-report 
- HDE 4939 OEM/ANSI translate problem in Windows menu 
- HDE 4958 OEM/ANSI translate problem when switching language 
- HDE 4955 Studio shows wrong function when error occurs in a subreport 
- https://support.dataaccess.com/Forums/showthread.php?61269-Where-is-my-report-data-This-

version-6-00-is-really-a-nightmare! 
- Group numbers are off by one after printing a subreport  
- Added message to find in Preview when string is not found 
- HDE 5002 Fixed problem with screens appearing gray 
- https://support.dataaccess.com/Forums/showthread.php?61387-Can-you-please-make-this-

space-wider 
- https://support.dataaccess.com/Forums/showthread.php?61384-Variable-Height-

Fields&highlight=variable+height 
- - https://support.dataaccess.com/Forums/showthread.php?61437-Creating-Label-Reports-

shows-ERROR 
- HDE 5010 Crash when printing barcode without data 
- Fixed problem with NVARCHAR(MAX) fields not displaying any data 
- Fixed problem with variable length fields (Memo and Binary) not working in Filter Function for 

the ODBC driver 
- Fixed error on first argument of the Propercase() function 

 
Library: 

- https://support.dataaccess.com/Forums/showthread.php?61403-OnReportPreviewClick-is-not-
firing-in-DF-19-00 

- Improved feedback when a function error occurs, including the possibility to copy the Function 
ID and the ability to find the Function ID in the DR Designer. 

- HDE 4969 https://support.dataaccess.com/Forums/showthread.php?61242-DR6-Reports-NOT-
printing-anymore-URGENT-!!! 

 
 

Changes between RC II and Release 
- Updated documentation 
- Added option to integrate the DataFlex Reports help into the DataFlex 19.0 Help system 

 
Bug fixes: 

- HDE 4909 Incorrect summaries when used inside a group based on a function 
- HDE 4886/4922 https://support.dataaccess.com/Forums/showthread.php?61137-Dataflex-

Reports-6-RC-2-Crashes-with-Sub-Report-in-Windows-10 
- HDE 4915 Group Sort Expert changes the sum to sort on when navigating through the groups 
- https://support.dataaccess.com/Forums/showthread.php?61126-DataFlex-Reports-RC-II-Select-

Case 
- https://support.dataaccess.com/Forums/showthread.php?61102-psPreviewWaitingGif 
- Fixed 'Invalid cursor state' error when using SQL() function 
- Fixed problem with incompatible data-types returned from SQL() function 

 
 
Changes between RC and RC II 

- Updated documentation 
- PreviewWaitingGIF() property added 
- Added option to set the ‘Wrap state’ of existing reports to the Maintenace utility 

 
Bug fixes: 

- HDE 4835/4857 SUM function output differs between report/page header and footer 
- Fixed problem in PDF export when white background color was used 
- 4839 Fixed problem with PDF export, the ‘End color’ is used even when ‘Gradient Type’ is set to 

‘Solid’ 



- Fixed problem with arrange objects always changing the distance of both X and Y axis 
- Fixed problem with CASE statement not working with some datatypes 
- Fixed error message during registration (MAC address error) 
- https://support.dataaccess.com/Forums/showthread.php?56773-Page-Numbering-

Bug&p=322510#post322510 
- https://support.dataaccess.com/Forums/showthread.php?60880-Report-SQL-Query-not-

showing-all-filters 
- Fixed problem with removing sub reports 
- HDE 4841 ‘Invalid bookmark value’ error when using ODBC and OEM character set 
- Fixed problem with ‘set datasource location’ dialog displaying subreports in wrong treeview 

branch 
- Fixed error message on right mouse-click in ‘Check Database’ dialog 
- Fixed problem with weird sort order when using AddSortField() from integration library 
- Fixed problem with Excel export skipping every other line 
- https://support.dataaccess.com/Forums/showthread.php?60941-Look-at-the-differences-

between-5-0-1-amp-6-00-it-s-blurry-It-is-not-subtle-at-all&highlight=blurry 
- https://support.dataaccess.com/Forums/showthread.php?56773-Page-Numbering-

Bug&highlight=reset+page+number 
- Fixed error message when closing main report with multiple opened subreports 
- HDE 4878 Cannot delete – unused – parameter 
- HDE 4806 Fixed problem with formatting when printing RTF text over multiple pages  
- Fixed memory overwrite 
- Improved comment support in function editor 
- https://support.dataaccess.com/Forums/showthread.php?61043-Reports-2017-RC-Error-108-

symbol-File-field-not-defined 
 

Library: 
- The cWebDRReportViewer class is updated. 
- Added support for DataFlex 19.0 tab-workspaces 
- cDRPreviewWindow class now sends PreviewPaint when a resize occurs (for tab-workspace 

support) 
- 18.0 library and higher; web.tpl (template) replaced with webPDF and webHTML templates 
- 19.0 library; icon and bitmap update 

 
 
Changes between Beta II and Release Candidate 
Bug fixes: 

- HDE 4752 https://support.dataaccess.com/Forums/showthread.php?60524-Arrange-Object-
spacing-possible-YAFR 

- https://support.dataaccess.com/Forums/showthread.php?60693-DR6-0-Display-Status-Panel-
flickering 

- https://support.dataaccess.com/Forums/showthread.php?60704-Text-field-Don-t-work-with-
special-characters 

- Exporting reports with charts in HTML and PDF draws the chart upside down 
- Chart legend marker ‘width’ and ‘height’ values were swapped 
- Fixed Barcode error messages 
- Fixed ‘invalid data type’ errors in copy/paste of subreports 
- Fixed problem with adding existing report as a subreport changing tab names in the Studio 
- Fixed problem with PDF passwords no longer working 
- HDE 4686 Paint problem with current selection of combo box 
- HDE 4762 First row on every page of Excel export is empty when using ‘Data only’ export 
- HDE 4764 Error opening Excel 2007 export file 
- Fixed problem with varchar(max) fields in ODBC being converted to ‘string’ fields instead of 

‘memo’ fields 
- Fixed problem with summaries on functions not working properly 
- ‘One or more table mismatches’ error in check database when using tables from multiple 

schemas 
- Changing the label size did not change the size of the details section 
- Fixed errors hen using some of the Barcode constants (constants with dash symbols) 
- Images on RDS are now 1 inch by 1 inch by default if no image sample is available 
- Fixed problems with copying/pasting objects between reports based on different data sources 
- Fixed error messages when copying/pasting from the report explorer 

 
Changes between Beta I and Beta II 

- JIT function pre-compiler 



- Added option for case-insensitive compare in functions. We recommend you turn this option on 
for all new reports (by default this option is turned on for new reports and off for existing 
reports). 

- '(null)' values will no longer appear in RDS reports 
- Variable length Memo and Binary fields. 
- Anchor support 
- Helper for drawing Lines/Boxes over sections. You can create Lines and Boxes spanning multiple 

sections by inserting a Line/Box while holding the Ctrl key. 
- New ‘TableNameAlias’ function in OCX 
- Updated integration library 

 
Bug fixes: 

- http://support.dataaccess.com/Forums/showthread.php?60036-DR-6-00-Barcode-Printing 
- HDE 4672 http://support.dataaccess.com/Forums/showthread.php?59388-quot-and-not-quot-

not-working-anymore-DR-5-01 
- HDE 4673 remove and reorder table columns 
- HDE 4696 http://support.dataaccess.com/Forums/showthread.php?60073-DR6-slow! 
- HDE 4687 http://support.dataaccess.com/Forums/showthread.php?60080-Table-with-many-

columns-produces-blank-output&highlight=lasso 
- http://support.dataaccess.com/Forums/showthread.php?57878-Subreport-in-Report 
- HDE 4724 Designer does not show italic fonts 
- HDE 4710 DR setup program installs the wrong DR.DB 
- HDE 4706 blank page after label report 
- HDE 4701 'Referenced array index out of bounds' error in designer 
- HDE 4700 Using section expert to change section height of label report 
- HDE 4698 Incorrect barcode colors used 
- HDE 4697 Barcode type constants are missing 
- HDE 4693 Unhandled program error when using extremely large fonts 
- HDE 4692/4694/4689 Unhandled program error when using spinforms with certain locale 

settings 
- HDE 4691 Export to HTML does not work with some images 
- HDE 4709 Export of barcode to PDF (high quality) does not work 
- HDE 4747 Invalid message error when aligning objects 
- Fixed error message for recursive functions 

 
Changes between 5.0.1 and 6.0 Beta I 
Implemented suggestions: 

- HDE 4612: Custom section names 
- HDE 4494: Extract page layer from report (see: 

http://support.dataaccess.com/Forums/showthread.php?59369-YAFR-Tool-to-extract-page-
layer-back-to-DPL-file-from-DR-file) 

- HDE 4337/4203/3445: Add CASE statement to functions (see: 
http://support.dataaccess.com/Forums/showthread.php?58781-Wishlist-Case-
statement&highlight=CASE) 

- HDE 4442: Select function in ‘Field Explorer’ after creation (see: 
http://support.dataaccess.com/Forums/showthread.php?59063-Suggestion-when-creating-a-
new-function) 

- HDE 4637: Copy suppress condition using the ‘Same formatting’ option (see: 
http://support.dataaccess.com/Forums/showthread.php?59915-YAFR-If-it-doesn-t-exist) 

- HDE 3960: Ability to specify the default JOIN type in options 
- HDE 4580: Ability to copy fields between reports (see: 

http://support.dataaccess.com/Forums/showthread.php?52439-YAFR-Copy-amp-Paste-
between-reports&highlight=copy+reports) 

- HDE 4660: Ability to get SQL statement for reports based on custom SQL (see: 
http://support.dataaccess.com/Forums/showthread.php?59001-Extracting-SQL-Statement-
from-Report&p=310378#post310378) 

- HDE 1676: Support for Embedded SQL/SQL expression fields 
- HDE 4483: Open function editor on error 
- HDE 4661: Add function for ‘Group Sort Number’ option in the group expert 
- HDE 3985: Print multiple sections at bottom of page 
- HDE 4542: make Tables, Views and Stored procedures available when not selected in options 

(see: http://support.dataaccess.com/Forums/showthread.php?59468-Creating-new-report-in-
Reports-5-0-don-t-show-my-stored-procedures&highlight=show+stored+procedures) 

- HDE 3389: Comment/Uncomment block in editor (see: 
http://support.dataaccess.com/Forums/showthread.php?52895-Few-Suggestions-amp-Bug-
reports-for-next-release&highlight=comment) 

- 4665: Ability to change the canvas (background color) of a report from integration 



 
 
Bug fixes: 

- HDE 4597/4466: ‘Size to font’ option clips data (see: 
http://support.dataaccess.com/Forums/showthread.php?59684-Possible-bug-Size-To-Font) 

- 4622: Default height of textbox differs from database fields 
- 4596: Different default function widths when inserting from menu (see: 

http://support.dataaccess.com/Forums/showthread.php?59698-Numeric-function-width-when-
inserting-from-the-Menu) 

- HDE 4432: Function return type incorrect when calling another function (see: 
http://support.dataaccess.com/Forums/showthread.php?58996-Isn-t-it-time-that-the-functions-
return-type-get-evaluated-correctly) 

- HDE 3166: Bug in ‘Database Expert’ (see: 
http://support.dataaccess.com/Forums/showthread.php?52071-Database-expert-
bug&highlight=database+expert) 

- HDE 4578: Refresh of ‘Field Explorer’ jumps to wrong item after dragging a field 
- HDE 4599/4496: Page layers do not respect ‘Word wrap’ option (see: 

http://support.dataaccess.com/Forums/showthread.php?59699-BUG-Page-Layer-File-not-
respecting-quot-Word-Wrap-quot) 

- HDE 4428: DR exits when using ‘Align to baseline’ on a text object and a line (see: 
http://support.dataaccess.com/Forums/showthread.php?58951-Small-bug) 

- HDE 4486: ‘Referenced Array Index Out of Bounds’ error when dragging a field while holding the 
Ctrl key 

- HDE 4550: Wrong icon for ‘Refresh’ in Report menu 
- HDE 4584: ‘Illegal datatype conversion’ error when using ‘Redo’ option in a subreport 
- HDE 4552: Delete row from sample RDS data does not work 
- HDE 4662: ‘Variable height’ field is missing the last line (see: 

http://support.dataaccess.com/Forums/showthread.php?59784-BUG-Print-of-a-variable-length-
field-is-missing-last-line) 

- HDE 4663: Group sort within a normal group does not work 
- HDE 4664: Alias names are not updated when using the ‘Change Datasource Wizard’ to convert 

a report from RDS to RDS 
- HDE 4643: ‘Table XXX has no column named XXX’ error when the column does exist 
- HDE 4370: Reserved words in RDS column names (see: 

http://support.dataaccess.com/Forums/showthread.php?58497-Baffled!!-RDS-Prblem-HELP!) 
- HDE 4667: Report options dialog shows the wrong label sizes 

 
 
Library: 

- HDE 4403: Replaced DownloadURL call in ExportReportToDownloadURL with 
CustomDownloadURL 

- HDE 4439: Implemented suggestion to add file extension to export filename if not specified in 
DRExportOptions.dg 

- HDE 4427: Repaint of preview after PreviewFind 
- HDE 4636: pbServerOnEscape set to true in DRPDFModalDialog.wo 
- HDE 4665: Added new method to set the color of the preview canvas 
- Moved the code previously generated by the wizard for the OnProgressRecordsRead and 

OnProgressFormatPage methods to the cDRReport class 
- Added new preview option for windows implemented in class cDRDesktopPreview 
- Excluded all methods unavailable in web applications in cDRReport with conditional compiler 

switch 
- Moved all methods and properties from cWebDRReport to cDRReport, the cWebDRReport is now 

an empty class and the wizard will generate a cDRReport 
 
Wizard Changes: 

- Added new preview option – DesktopView – similar to the tool-panel but with additional button 
in the windows task bar 

- OnProgressRecordsRead and OnProgressFormatPage methods are no longer generated 
  



What is New in version 6.0?  

 
Barcode support 
 
DataFlex Reports 6.0 supports over 70 different types of symbologies (type of barcodes) both one-
dimensional and two-dimensional (stacked) symbols are available. Fields (like database fields, functions 
or parameter fields and text objects) can be converted to a barcode with a simple mouse click and can 
be exported to PDF, RTF, HTML or image.  
 

 
 

 
Performance improvements 

Version 6 of DataFlex Reports contains many performance improvements to optimize the report 
generation process. A function pre-compiler has been added which makes reports with lots of functions 
run up to 10(!) times faster; the performance of summaries (both summary fields and the Sum() 
function) has also dramatically improved. Additional changes have been made to the layout engine to 
streamline the report generation. 
 
  



Functions and function editor 

A new case statement has been added to version 6 of DataFlex Reports. The case statement supports 
comma separated lists of values and does not allow fall-through to occur. Case statements can be 
nested. In addition to the case statement, whenever a function error occurs, the function editor is 
opened and the symbol which caused the error is highlighted. Selected text can now be commented and 
uncommented using the Ctrl+K,C and Ctrl+K,U keys or toolbar buttons. Additionally line comments can 
be toggled using the Ctrl+/ key. 
 

 
 
 



Embedded SQL 

A new built-in function SQL() has been added to DataFlex Reports 6.0 which allows you to execute SQL 
statements directly (also known as SQL expressions). This function is only available for ODBC data-
sources and is a powerful addition to report developers. However, only a single value can be returned 
from a SQL() function.  
 

 
 
 
  
 
Suggestions and bug fixes 
DataFlex Reports 6.0 includes over 30 implemented user suggestions and bug-fixes. See the ‘Changes’ 
section in this readme for a complete list. 

 
  



Existing DataFlex Reports 4.x user information 

All classes, constants and files in the DataFlex Reports integration – included in this version – have been 

renamed as part of the rebranding of the DataFlex Reports product. For existing pre-DataFlex Reports 

4.0 applications create a backup of your existing project(s) and take the following steps to update to the 

6.1.5 library: 

 

Remove the existing DataFlex Reports library and add the DataFlex Reports 6.1.5 library to your 

workspace (this may require you to start the DataFlex Studio with administrator rights). 
 

1. Click the replace in files button in the Studio (Ctrl+Shift+H) 
a. Enter VRW in the “Text to Find” input field 
b. Enter DR in the “Text to Replace” input field 
c. Click the “Replace All” button 

2. Open the <projectname>.cfg file 
a. Replace all VRW with DR for the icons and bitmaps 

3. Search for the usage of psDatabaseCollate and remove the code. The property does not exist 
anymore 

4. Windows projects 
a. Replace all occurrences of “cCJSortColumnsGrid” with “cDRSortColumnsGrid” 
b. Replace all occurrences of “cCJSortDirectionsGridColumn” with 

“cDRSortDirectionsGridColumn” 
5. Web Application Framework projects 

a. Replace all occurrences of “oPDFModalDialog” with “oDRPDFModalDialog” 
b. Replace all occurrences of “Use PDFModalDialog.wo” with “Use DRPDFModalDialog.wo” 

6. Optional: 
a. Replace all “.vrw” to “.dr” in the program code 
b. Rename all reports with a VRW extension to DR            

 
 
Language support  
DataFlex Reports ships with support for a number of languages. Before changing the language used in 
DataFlex Reports you must set your Windows Regional Options to the language of your choice. This 
ensures that the correct (ANSI) code page is selected in Windows. You can change the Regional Options 
in the Windows Control Panel, for full language support you must change both the ‘Standards and 
formats’ option to ensure correct date and number handling and the ‘Language for non-unicode 
programs’ option. Please note that the name of these options may differ in various versions of Windows. 
After changing the Windows Regional Options you can change the language in DataFlex Reports by 
choosing a language from the ‘Language’ menu.  
 
Integration library  
DataFlex Reports comes with an Integration library. This library allows you to seamlessly integrate 
reports with your DataFlex 16.x, 17.x, 18.x or 19.0 applications. The library contains an Integration 
Wizard and classes for integrating and viewing reports. During installation you can specify the location of 
the Integration library. We suggest you install the library in a subfolder of the main DataFlex directory, 
this allows you to add the library using relative paths. To use the Integration library and Integration 
Wizard in your DataFlex projects and Workspaces you must first add the library. You can do this by 
opening the DataFlex Studio and select the ‘Maintain Libraries…’ option from the ‘Tools’ menu. Next, you 
can use the ‘Add Library’ button and open the ‘DataFlex Reports XXX.sws’ file. After selecting the .sws 
file and clicking the ‘Ok’ button a wizard will be started which will guide you through the process of 
adding the library to the currently selected workspace.  
For windows application, simply choose the ‘View/Report’ option from the ‘File’ menu and select the 
‘DataFlex Reports Wizard’ icon. For Web applications use the ‘Web Object’ option from the ‘File’ menu.  
 

Reporting bugs, comments and suggestions  

Please report bugs to support@dataaccess.eu, if you have a HelpDesk Express account you can also 
enter reports directly at http://hde.dataaccess.eu. Make sure to provide as much detail as possible to 
define and reproduce the problem that you are reporting. Upon your report, you will be invited to use an 
account on our help-desk support system for reporting future issues. For further communications and 
information, there is a forum devoted to DataFlex Reports in the Data Access Worldwide Support 
Forums. 


